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1 Introduction

1.1 Introducing R:Twain2PDF X.5

R:Twain2PDF is a compact utility program placed into a easy-to-use interface for gathering JPG images
and TWAIN sources to produce PDF documents, with full ADF (automatic document feeder) support. You
can select from a list of available TWAIN sources or from a scanner to capture images. R:Twain2PDF
uses the TWAIN driver which is included with your scanner or TWAIN device, and not the actual product
software. Image compression options for R:Twain2PDF include Flate and Jpeg. 

The PDF Document Properties allow you to add document information to the PDF output. R:Twain2PDF
also supports 128-bit encryption and user permissions. Several Page Layout, Page Mode, and Viewer
Preferences are available.

R:Twain2PDF can be launched with the available executable, or can be launched behind the scenes within
an application using the available Plugin, both of which that are provided with the software.

Being fully compatible with R:BASE, R:Twain2PDF includes a Plugin for automation of scanning
documents within your R:BASE applications. Or, you can use the graphic user interface to quickly create
secure PDF documents.

1.2 Copyrights

Information in this document, including URL and other Internet web site references, is subject to change
without notice. The example companies, individuals, products, organizations and events depicted herein
are completely fictitious. Any similarity to a company, individual, product, organization or event is
completely unintentional. R:BASE Technologies, Inc. shall not be liable for errors contained herein or for
incidental consequential damages in connection with the furnishing, performance, or use of this material.
This document contains proprietary information, which is protected by copyright. Complying with all
applicable copyright laws is the responsibility of the user. Without limiting the rights under copyright, no
part of this document may be reproduced, stored in or introduced into a retrieval system, or transmitted
in any form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or for any
purpose, without the express written consent of R:BASE Technologies, Inc. We reserve the right to make
changes from time to time in the contents hereof without obligation to notify any person of such revision
or changes. We also reserve the right to change the specification without notice and may therefore not
coincide with the contents of this document. The manufacturer assumes no responsibilities with regard to
the performance or use of third party products.

Products that are referred to in this document may be either trademarks and/or registered trademarks of
the respective owners. The publisher and the author make no claim to these trademarks.

The software described in this document is furnished under a license agreement. The software may be
used or copied only in accordance with the terms of that agreement. Any unauthorized use or duplication
of the software is forbidden.

R:BASE Technologies, Inc. may have patents, patent applications, trademarks, copyrights, or other
intellectual property rights covering subject matter in this document. Except as expressly provided in any
written license agreement from R:BASE Technologies, Inc., the furnishing of this document does not give
you any license to these patents, trademarks, copyrights, or other intellectual property.

Trademarks

R:BASE®, Oterro®, RBAdmin®, R:Scope®, R:Mail®, R:Charts®, R:Spell Checker®, R:Docs®, R:BASE
Editor®, R:BASE Plugin Power Pack®, R:Style®, RBZip®, R:Mail Editor®, R:BASE Dependency Viewer®,
R:Archive®, R:Chat®, R:PDF Form Filler®, R:FTPClient®, R:SFTPClient®, R:PDFWorks®, R:Magellan®,
R:WEB Reports®, R:WEB Gateway®, R:PDFMerge®, R:PDFSearch®, R:Documenter®, RBInstaller®,
RBUpdater®, R:AmazonS3®, R:GAP®, R:Mail Viewer®, R:Capture®, R:Synchronizer®, R:Biometric®,
R:CAD Viewer®, R:DXF®, R:Twain2PDF®, R:Tango®, R:Scheduler®, R:Scribbler®, R:SmartSig®,
R:OutLink®, R:HASH®, R:JobTrack®, R:TimeTrack®, R:Manufacturing®, R:GeoCoder®, R:Code®,
R:Fax®, R:QBDataDirect®, R:QBSynchronizer®, R:QBDBExtractor®, and Pocket R:BASE® are
trademarks or registered trademarks of R:BASE Technologies, Inc. All Rights Reserved. All other brand,
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product names, company names and logos are trademarks or registered trademarks of their respective
companies.

Windows, Windows 11-10, Windows Server 2022-2012, Bing Maps, Excel, Access, SQL Server, and
Outlook are registered trademarks of Microsoft Corporation. OpenOffice is a registered trademark of the
Apache Software Foundation. 

Printed:  February  2024 in Murrysville, PA

First Edition

1.3 License

R:BASE TECHNOLOGIES, INC. LICENSE AGREEMENT 
 

R:Twain2PDF X.5
Single Seat License

This is a legal agreement between you, the end user ("Licensee"), and R:BASE Technologies, Inc.
("RBTI"). Please read the terms and conditions of this License Agreement before using this software. By
you selecting "I accept the license agreement" and clicking "Next" during product installation means you
expressly accept the terms and conditions of this Agreement. If you do not accept the terms and
conditions of this Agreement, you must stop installing the Product and click "Cancel". Your money will be
refunded based upon proof of purchase, and in compliance with the return period described in the
LIMITED WARRANTY below. A violation of the License, brings damage both financially and to the
reputation of RBTI, and in the occurrence of either, both termination of the license agreement and civil
damages will be vigorously sought. Once you have clicked "I accept the license agreement", you are
entitled to use the Product under the following terms and conditions of this Agreement:

LICENSE
This RBTI License Agreement permits you to use one copy of the R:Twain2PDF computer software with
associated utilities (the “Program”) and accompanying user documentation (the “Documentation”) on
any single computer. If you do not have a Site License or at least one 5 Seat Add-On License, this
program can only be installed on a single machine. However, you can open multiple sessions and be
connected to the same and/or other local or network databases on the same machine simultaneously.
(The 5 Seat Add-On License permits additional seats to access the Program, in 5 seat increments if each
is physically linked to a single file server and you have obtained a separate license for a Single Seat
version of the Program. 5 Seat Add-On Licenses must be licensed at the same Single Seat version). A
Program is “being used” on a computer when it is loaded into a temporary memory or installed on a hard
drive in the computer. However, a copy of the Program installed on a network server for the sole
purpose of distribution to other computers is not “being used”. Each seat having access to the Program
must have an appropriate license. If you anticipate that the number of seats with access to the Program
will exceed the number of seats for which you are licensed, you must take steps to ensure that the
appropriate licenses are obtained for each seat.

5 SEAT ADD-ON AND SITE LICENSES 
If a printed or other form of “hard-copy” License accompanied the copy of the Program you received
whose terms vary from this agreement, then the hard-copy License governs your use of the Program. 5
Seat Add-On and Site Licenses allow you to install the Program on the total number of machines for
which you are licensed only.

SATELLITE LICENSES
A Satellite License permits a Licensee to use one copy of the copy of the Program on any additional
single computer, for additional development to accompany an existing Single Seat License. The Satellite
License must be licensed to the same user as the existing Single Seat License. Each seat having access
to the Program must have an appropriate license.

COPYRIGHT AND RESTRICTIONS
RBTI retains full ownership rights in the Program and Documentation. You may make a single copy of the
Program; to be used solely for backup or archival purposes, or you may transfer the Program onto a
single hard disk provided you keep the original solely for backup or archival purposes. Such copies shall
be owned by RBTI. You may not copy any printed material or Documentation without prior permission.
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You may not decompile, disassemble cross-compile, reverse engineer, or make or distribute any other
form of, or derivative work from, the Program. You may not obscure, alter or remove any RBTI
copyright, trademark or proprietary rights notices.

TRANSFER OF LICENSE
You may not lend, rent or lease the Program or Documentation or any copies to any person. A transfer
of license is only authorized through completion of the Consent to Assignment and Assumption of
Contract agreement from RBTI. Upon license transfer, you are permanently giving such person
possession of all copies of the Program and Documentation, are permanently giving up your right to use
the Program and Documentation, and the recipient agrees to the terms of this License Agreement. 

STEP UPS AND UPGRADE PURCHASES
As the Licensee, you are authorized to use the Program only if you are an authorized user of a qualifying
product as determined by RBTI. The new license agreement takes the place of the agreement of the
qualifying software you stepped up or upgraded from. After you upgrade, you may no longer use the
software from which you upgraded. When you install the upgrade, you must uninstall the copy of the
qualifying product.

TERM OF LICENSE
The licensing provided in this License Agreement is perpetual unless you violate any of its terms or
conditions, at which time the license will automatically terminate. Upon termination you must return all
copies of the Program and Documentation to RBTI or certify in writing to RBTI that all such copies have
been destroyed and uninstalled from each workstation and/or network server. RBTI reserves the right to,
at its expense and without prior notice, conduct periodic inspections for licensing compliancy. If licensee
is found to be in violation of current agreement, RBTI may commence a civil action seeking fines,
damages, attorney’s fees and injunctive relief and may also, in appropriate circumstances, seek criminal
prosecution.

ACTIVATION CODES
The Program requires activation using a unique code. If you purchase a Single Seat License with or
without 5 Seat Add-On Licenses, you agree to comply with the license activation and verification
procedure described in this section of the Agreement. The activation technology may prevent your use of
the Program if you do not follow the activation process described in this Agreement. 

Each activation code is tied to one Windows operating system computer. A dual-boot computer with
multiple operating systems cannot activate a Single Seat License on more than one operating system.
Any software utilities which alter how the Program is installed on a local drive are not supported. This
includes any utilities which alter, remove or transfer the location of the Program on the hard drive, or
any hard drive utilities which alter the physical properties of the local drive.

The Program activation can be completed automatically through an Internet connection or manually
through a provided email option. In doing so, the Program Registration Number and Computer ID must
be provided. License validation allows a number of activations based upon the number of licenses
purchased.

If a computer is no longer using the Program, through license transfer or hardware failure, the Activation
Key that was used on the computer must be submitted to R:BASE Technologies so the key may be
disabled, which will then free up that used activation. Once a key is reported as no longer in use and
deactivated, it can no longer be used on that computer. Product deactivation can be performed
automatically from within R:BASE. To review the License Key and Activation Key product information,
select "Help" > "Product Activation" from the Menu Bar. 

Licenses for the Corporate VIP Licenses of the Program are not controlled by activation codes and can be
operated from computers that are not connected to the Internet.

SOFTWARE SUPPORT
The availability of software support services is subject to the End of Support (EOS) and End of Life (EOL)
product life cycle, and to an active Software Assurance Plan. Where applicable, licensees will be provided
with an option to upgrade to the current supported version of a software product.

LIMITED WARRANTY
RBTI warrants to you, as the initial user, the Program will perform substantially in accordance with the
Documentation, provided it is used in unaltered form with functioning equipment and operating systems
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for which it was designed. RBTI will, at its option, with proof of payment within 30 days of the invoice
date and after the Program with Documentation has been deactivated and uninstalled, and software
installer, whether provided by download or other means, permanently deleted from all drives and
folders, issue a full refund. These are your sole remedies for any breach of warranty. No exceptions will
be made.

SERVICES PROVIDED WITH PURCHASE

1. 30-Day Limited Complimentary Technical Support 

LICENSEE RESPONSIBILITIES

· To help us expedite the process and provide high quality assistance, the licensee must
provide proof of purchase when calling. Proof of purchase is defined as the following:
registration number, purchase date, version and build number, and company or individual to
which product is registered.

· To have operating system, workstations, and local network installed and functional. RBTI will
NOT be responsible for resolving issues not pertaining to the Program.

· Our support staff deals with advanced issues, therefore the person contacting RBTI for
assistance should be the system administrator or have other R:BASE/SQL experience and be
able to understand and implement the advice given.

· To have the database(s) being converted, safely backed-up before attempting conversion
process.  RBTI will NOT be held responsible for lost data or corruption as a result of advice
given.

R:BASE TECHNOLOGIES, INC.  RESPONSIBILITIES
· To provide quality assistance in a timely manner to aid Licensee in the installation of the

product within 30 days of the date of purchase.
· To provide a reasonable solution for any resolvable issue.  Not all issues are resolvable, and

therefore we will acknowledge the existence of known issues or “bugs” which we are
presently aware of, that have no reasonable work-around.

RBTI reserves the right to limit the amount of support time allotted to a maximum of 2 HOURS
during the 30-Day Complimentary Technical Support Period.  We also reserve the right to limit the
quantity of calls from a particular Licensee to 30 MINUTES in a single day.  Issues are dealt with
on a case-by-case basis, and are handled at the discretion of the support agent assigned to the
case. Complimentary Support is limited to INSTALLATION and ELEMENTARY CONVERSION related
issues ONLY. Our support hours are from 10am. to 6pm. Eastern Time.

For assistance on your APPLICATIONS, DESIGN, or ADVANCED CONVERSION issues, we offer
Technical Support Plans of various types to meet your needs.  Please visit the SUPPORT area of
our website at www.rbase.com for details and pricing.

2. Fixes for Known Issues
RBTI will provide continued product fixes for known issues or “bugs” for 1 YEAR from the software
purchase date. After 1 year, users are urged to acquire the necessary Software Assurance Plan to
continue with product support and ongoing activations for reinstallations and license transfers.

3. Enhancement Requests
RBTI will provide continued product enhancements for requested features for 1 YEAR from the
software purchase date. After 1 year, users are urged to acquire the necessary Software Assurance
Plan to continue with product support and ongoing activations for reinstallations and license transfers.

4. Periodic Activations
RBTI will provide periodic product activations of license transfers and/or reinstallations for 1 YEAR
from the R:BASE purchase date. Any activation requests that occur beyond the 1 Year purchase date
will require an active Software Assurance Plan.

NO OTHER WARRANTIES
Except as explicitly stated above, RBTI makes no express or implied warranties (including any warranties
of merchantability or fitness) with respect to the character, function, or capabilities of the program, the
documentation or their appropriateness for any user’s purposes. RBTI cannot customize product(s) to
meet specific needs in all cases. Examples of customization include, but are not limited to: special
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character sets, foreign language adaptations, specific device drivers or other localization issues. Under
no circumstances will RBTI be held responsible for product functionality once alterations have been made
to accommodate individual needs.

DISCLAIMER OF WARRANTY
The Program and the accompanying files are sold "as is" and without warranties as to performance or
merchantability or any other warranties whether expressed or implied. Because of the various hardware
and software environments into which the Program may be put, No warranty of fitness for a particular
purpose is offered. Good data processing procedure dictates that any program be thoroughly tested with
non-critical data before relying on it. The user must assume the entire risk of using the Program. Any
liability of the seller will be limited exclusively to product replacement or refund of purchase price.

HIGH RISK ACTIVITIES
The Program is not fault-tolerant and is not designed, manufactured or intended for use or resale as on-
line control equipment in hazardous environments requiring fail-safe performance, such as in the
operation of nuclear facilities, air traffic control, aircraft navigation or communication systems, direct life
support machines, or weapons systems, in which the failure of the Program could lead directly to death,
personal injury, or severe physical or environmental damage ("High Risk Activities"). RBTI specifically
disclaims any expression or implied warranty of fitness for High Risk Activities. 

LIMITATIONS ON LIABILITIES
RBTI will not be responsible for any costs or damages associated with loss of the use of the Program or
any other resources, loss of business or profits, any loss of data, any third-party claims or costs of
substitute programs. In no event will RBTI be liable for any incidental, indirect, special, consequential or
punitive damages suffered by the user or any other person or entity, whether from the use of the
program or documentation, any failure thereof, or otherwise, even if RBTI or its dealers or agents are
aware of the possibility of such damages. In no event will RBTI aggregate liability to you or anyone else
exceed two times the license fee you paid for the program and documentation in this package. Because
some states do not allow the limitation or exclusion of implied warranties and liabilities for consequential
or incidental damages, the above limitations may not apply to you.

GENERAL
This License Agreement constitutes the full and complete agreement between parties. RBTI retains all
rights not specifically granted herein. RBTI shall not be deemed to have waived any of its rights
hereunder or under all copyright laws, trade secrecy laws or otherwise. This Agreement is intended as a
legally binding agreement which will be enforced to the full extent permitted under applicable law, in
whole or in part. If any one provision of this Agreement is declared invalid or unenforceable, all
remaining provisions shall never less remain in effect. The laws of the state of Pennsylvania shall govern
this Agreement. RBTI reserves the right to amend, alter, or revoke this agreement at any time. All
revisions to this license agreement are available for inspection upon request, supersede conditions in all
past agreements, and render prior license agreements void and unenforceable. Both parties named in
this license will only be bound to the terms of the most current revision of this agreement.

U.S. GOVERNMENT RESTRICTED RIGHTS
Use, duplication or disclosure by the Government, its agents or employees is subject to all restrictions
imposed by law, regulation or government directive, including but not limited to those restrictions set
forth in DFARS 252.227-7013 and 48CFR 52.227-19, as applicable.

R:BASE Technologies, Inc.
https://www.rbase.com
rbaseinfo@rbase.com

Copyright 1982-2024 R:BASE Technologies, Inc. 
All Rights Reserved
Revised Tuesday, February 06, 2024

1.4 Complimentary Technical Support

30 DAY LIMITED COMPLIMENTARY TECHNICAL SUPPORT

A. LICENSEE RESPONSIBILITIES.
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1. To help us expedite the process and provide high quality assistance, the licensee must provide
proof of purchase. Proof of purchase is defined as the following: registration number, purchase
date, version and build number, and company or individual to which product is registered.

2. To have operating system, workstations, and local network installed and functional. R:BASE
Technologies will NOT be responsible for resolving issues not pertaining to the software product.

3. Our support staff deals with advanced issues, therefore the person contacting R:BASE Technologies
for assistance should be the system administrator or have other R:BASE/SQL experience and be
able to understand and implement the advice given.

4. To have the database, application, and command files being reviewed, safely backed-up before
attempting assistance. R:BASE Technologies will NOT be held responsible for lost data or corruption
as a result of advice given.

B. R:BASE TECHNOLOGIES, INC. RESPONSIBILITIES.

1. To provide quality assistance in a timely manner to aid in the installation of the product and
elementary conversion of database, application, and command files within 30 days of the date of
purchase.

2. To provide a reasonable solution for any solvable issue. Not all issues may be solved, and
therefore we will acknowledge the existence of known issues, or bugs, which we are presently
aware of, that have no reasonable work-around.

R:BASE Technologies reserves the right to limit the amount of support time allotted to a maximum of 2
HOURS during the 30-Day Complimentary Technical Support period. We also reserve the right to limit the
quantity of calls from a particular licensee to 30 MINUTES in a single day. Issues are dealt with on a
case-by-case basis, and are handled at the discretion of the support agent assigned to the case.
Complimentary Support is limited to INSTALLATION and ELEMENTARY CONVERSION related issues ONLY.
Our support hours are Monday through Friday, from 10:00 AM to 6:00 PM (EST).

For application, design, or advanced conversion assistance, R:BASE Technologies offers Technical
Support Plans of various types to meet your needs. Please visit the Support page at
https://www.rbase.com/support for details and pricing.

https://www.rbase.com/support
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2 Installation

2.1 System Requirements

The following system specifications are recommended for the optimal use of R:BASE and R:BASE-related
software. 

Workstation Hardware

· 2-Core 2GHz+ CPU
· 2 GB of available RAM (4 GB recommended)
· 2 GB of available hard disk space
· 1024x768 or higher resolution video adapter and display
· Standard mouse or compatible pointing device
· Standard keyboard

Server Hardware

· 2-Core 2GHz+ CPU
· 6 GB of available RAM (8 GB recommended)

Operating System

· Microsoft Windows 11 (Professional)
· Microsoft Windows 10 (Professional)
· Microsoft Windows Server 2022
· Microsoft Windows Server 2019
· Microsoft Windows Server 2016
· Microsoft Windows Server 2012, 2012 R2

Network

· Ethernet infrastructure (Gigabyte recommended)
· Internet connection recommended, but not required, for license activation, software updates, and

support
· Anti-virus programs should exclude the R:BASE program, and any add-on product, executable and

database files

2.2 Things You Will Need

· License Key

Before launching the installer, it is recommended that you have your 32-character License Key readily
available. The License Key is provided in a document, with the email message, when the software was
originally purchased. If you have lost or misplaced your License Key, please contact our Support Staff
by email at support@rbase.com.

· Internet Access

The computer where the software will be launched should have access to the Internet for activation.
The Internet access is used to visit the R:BASE Technologies Web site to provide your required
Activation Key.

In instances where the software will be installed on a computer that is not connected to the Internet,
you must then contact R:BASE Technologies to provide information displayed on the computer screen.
Please contact our Product Activation Staff by email at activationkey@rbase.com. The Registration
Number must be provided. The Registration Number is displayed on the invoice/order slip, and within
the email, when the software was originally purchased.

mailto:support@rbase.com
mailto:activationkey@rbase.com
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2.3 Software Installation

The installation of R:Twain2PDF is fully automated and does not require user intervention for the initial
setup. 

Run the installer ".exe", provided by download, while physically sitting at the workstation to begin the
installation process, and read the installer screens for licensing and other information as the program
installs.

Installation Directory

C:\RBTI\RTwain2PDFX5

Files Installed

RTwain2PDFX5.exe
RTwain2PDFX5.rbm
RTwain2PDFX5.pdf
RTwain2PDFX5.chm
ReadMe.txt
License.rtf

Requirements:

Plugin
The R:Twain2PDF X.5 Plugin file (RTwain2PDFX5.rbm) must be placed in the R:BASE X.5 program
directory or the runtime/compiled application directory. 

R:BASE Version Default Program Directory

X.5 (Version 10.5) C:\RBTI\RBGX5

X.5 Enterprise (Version 10.5) C:\RBTI\RBGX5E

2.4 Plugin Activation

R:BASE Plugins can be used to enhance, or extend R:BASE operations. Current R:BASE Plugins use the
.RBM file extension. 

To begin using any plugin product, the plugin must be registered for use. 

The license type for R:BASE and R:BASE plugin products must match. The license keys supplied with
Single Seat and 5 Seat plugin products will only be accepted within Single Seat and 5 Seat versions of
R:BASE, and are not accepted within R:Compiler for R:BASE or Runtime for R:BASE programs. The same
license structure is also in place for Runtime License Keys for plugin products, where the key will not be
accepted within Single Seat and 5 Seat Licenses R:BASE. 

2.4.1 R:BASE

To begin using a plugin product, you must register the software within R:BASE by selecting "Help" >
"Product Activation" from the main Menu Bar. In this window, select the "Add New" button where you can
enter or copy and paste the License Key you received with your product. 

Only "Per Seat" License Keys are valid for this entry screen. All "Runtime" License Keys must be
registered within R:Compiler for R:BASE or within Runtime for R:BASE separately.
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After entering the License Key, you will see a dialog to prompt for your activation method. The software
can be activated automatically over the Internet, or manually by retrieving an Activation Key from
R:BASE Technologies by email or over the phone. If you select "Later", you will be reminded each time
R:BASE starts to activate your copy.

When activating the software manually, you select the e-mail link to launch your email client and send a
pre-formatted message to R:BASE Technologies that will contain your License Key and the displayed
Computer ID. You will need to provide your R:BASE Registration Number and Computer ID.
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At any time, you can review your product information by starting R:BASE, and from the Menu Bar
clicking on "Help" > "Product Activation". Your R:BASE Registration Number is displayed on the window.
You can also enter additional License Keys for R:BASE add-on products.

Please be advised that if you are activating multiple workstations, it is highly recommended
that you keep records of the computer name, Computer ID and Activation Key for future
reference. Access to this information will prove convenient in the event of a hardware
failure or license transfer when uninstalling R:BASE. 

Please see: Uninstall/Reinstall
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2.4.2 R:Compiler for R:BASE

Runtime License Key
Runtime license keys for an R:BASE Plugin must be stored within the compiled executable. A specific
Runtime License Key would be provided after your purchase of the Runtime software product. Adding a
Runtime License to your project can be done by selecting the "Add License" button, and pasting the
appropriate Runtime License Key into the displayed dialog window.

After a Runtime License is added as a resource, it  will be assigned a "Resource ID". This ID consists of
the word "License" and an incrementing value for the number of licenses added to the executable. 

Plugin File (.RBM)
R:BASE Plugin files can be added and stored within the compiled executable or included within the
R:BASE application directory. The Runtime license key pertaining to the R:BASE Plugin must be stored in
the compiled executable.

Adding a Plugin to the list of resources can be performed by selecting the "Add Plugin" button on the Tool
Bar. You will be prompted to locate the appropriate Plugin file with the .RBM file extension. After a Plugin
file is added as a resource, it will be assigned a "Resource ID". This ID consists of the Plugin file name. 

2.4.3 Runtime for R:BASE

After R:BASE Plugins are acquired for Runtime for R:BASE applications, the Plugin file must be included
in the Runtime application folder, to be loaded when the Runtime application launches. 

To load the Plugin, the License Key must be included into the Runtime for R:BASE session by adding the
following PROPERTY command within the application startup file: 

   PROPERTY ADD_LICENSE ####-####-####-####-####-####-####-#### ' '
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3 Uninstall

If a computer is no longer using R:Twain2PDF, through license transfer or hardware failure, the
Activation Key that was used on that computer must be submitted to R:BASE Technologies so we can
then remove the Activation Key from our log. We will disable the Key, which will then free up that used
activation. Once a key is reported to us as no longer in use and deactivated, it can no longer be used on
that computer. 

Product deactivation can be performed automatically from within R:BASE. To review your product
information select "Help" > "Product Activation" from the Menu Bar. Here, the License Key and Activation
Key for a selected product is available for review. 

If the License Key for your product is not readily available for the license transfer, select the "Copy
License Key" button to send your License Key to the clipboard. 

To deactivate a listed product, select it and press the "Deactivate" button. The below confirmation dialog
will appear. After selecting "Yes", the product will be removed from the list.
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After completing the deactivation of the product, it can be successfully reinstalled and activated.
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4 Using R:Twain2PDF

4.1 User Interface

The easy-to-use interface is simple yet very powerful. The menu or toolbar can be used to acquire
images from your computer or from a TWAIN/scanner device.

4.1.1 Tool Bar

Button Description

Creates a new project and clears all current
items in the work space

Adds images to the work space

Deletes the selected item from the work space

Launches the Select Source dialog to select
available TWAIN sources

Initiates the available scanner to scan images

Saves the current work space project to a PDF
document

Compresses the image size using the "Flate" or
"Jpeg" method

Launches the PDF Document Settings dialog to
assign information, security, etc.
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Launches the R:Twain2PDF Help

Displays product information, like version 

Exits R:Twain2PDF 

4.1.2 Add/Delete Images

Add Images
To add images to the work space, select the "Add Images" button from the Tool Bar, browse for your
image(s), and select OK

Delete Images
To delete images from the work space, click on the image you want removed from the work space and
select the "Delete Images" button from the Tool Bar.

4.1.3 Select Source

To acquire images to the work space from a selected source, select the "Select Source..." button from
the Tool Bar. The following dialog will be displayed with a list of TWAIN sources.

4.1.4 Image Compression

Flate - Text data in the PDF is compressed and images retain original compression. File size and quality
is determined by the original image.

Jpeg - a lossy compression algorithm that has been conceived to reduce the file size of natural,
photographic-like true-color images as much as possible without affecting the quality of the image.
 

4.1.5 PDF Document Properties

The PDF Document Properties allow you to add document information to the PDF output. 

4.1.5.1 General

Title - title of document
Subject - subject of document
Author - author of document
Keywords - keywords of document
Creator - creator of document
Producer - producer of document (read only) 

Open After Save - enables/disables opening the document after it is saved
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4.1.5.2 Security

Encrypt Document - enables/disables encryption 
Owner Password - owner password for the document
Confirm Owner Password - confirmation of owner password for document
User Password - user password for document
Confirm User Password - confirmation of user password
Encryption Level - encryption level option for 40 bit or 128 bit

User Permissions 
Print - enables/disables permission to print the document
Modify Structure - enables/disables permission to modify document structure
Copy Information - enables/disables permission to copy information from the document
Modify Annotation - enables/disables permission to modify annotation 
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4.1.5.3 View

Page Layout - options for page layout. See PDF_PAGE_LAYOUT.
Page Mode - options for page mode. See PDF_PAGE_MODE.

Viewer Preferences
Hide Toolbars - hides/displays toolbars
Hide Menu Bar - hides/displays the Menu Bar
Hide Window UI - hides/displays the Window User Interface
Fit Window -  hides/displays the "Fit Window" button
Center Window -  hides/displays the "Center Window" button
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4.1.6 R:Twain2PDF Image Editor

The R:Twain2PDF Image Editor provides many advanced features to manage and manipulate images for
your R:BASE data. 

To launch the image editor, double click an image after it is added to R:Twain2PDF.
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4.1.6.1 Menu Bar

File

· Print - prints the current document to the default printer
· Printer Setup... - opens the Print Setup dialog for changing page specific settings

Edit

· Undo - undoes the last change made
· Copy - copies the currently selected image
· Paste New Image - inserts or pastes the currently cut or copied image
· Copy Selection - copies the current selection
· Paste into Selection - replaces the contents of the selection with the clipboard data
· Crop to Selection - deletes everything except the selection and reduces the image size to the length

and width of the selection

View

· Anti Aliased - makes diagonal edges appear smoother by setting pixels near the edge to intermediate
colors according to where the edge crosses them

· Centered - centers the document in the middle of the screen
· Mouse Mode - changes the mouse mode for image editing 
· Actual Size - displays the image at its actual size
· Fit Width - fits the image into the window width
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· Fit Height - fits the image into the window height
· Fit to Page - fits the image within the page

Image

· Rotate - rotates an image around its center point
· Flip - flips an image vertically or horizontally
· Negative - replaces each pixel color with its opposite on the color wheel
· Smooth - applies smoothing to the pixels at edges and corners
· Sharpen - increases the contrast between adjacent pixels by lightening the light pixels and darkening

the dark pixels
· Brightness - lightens the image
· Contrast - changes the amount of shading between areas
· Gamma... - opens the Gamma dialog box to adjust the mid tones and color balance of an image
· Edge Detection - marks the points at which the intensity changes sharply
· Emboss - highlights the areas of contrast with black or white pixels and colors the low contrast areas a

medium grey
· Convert to Gray - converts the image to gray colors
· Format Conversion... - displays the Format Conversion dialog 
· Resize - changes the size of the image

Format Conversion
The following color conversion options are available for the displayed image:

· Black and White
· 16 Shades of Gray
· 256 Shades of Gray
· 16 Colors
· 256 Colors

· Floyd Steinberg Dither - enhances the image by looking at the current pixel color and
retrieving the closest values from the palette. These colors are then distributed to the pixel
areas below and to the right of the original pixel.

· Quantize - reduces the number of colors in an image

4.2 Command Syntax

Syntax:

PLUGIN RTwain2PDF vResult|Parameters

Where:

vResult is the text variable to return the status, such as 'OK' or the exact -ERROR- message 

Parameters:

Parameter Value Description

SHOW_WINDOW ON
OFF

shows/hides the R:TWain2PDF
dialog window

OUTPUT_FILE value PDF file name

OUTPUT_FORMAT SINGLE_PDF enables the creation of one PDF
file per image 

INPUT_FILE value Specifies the Input text file
name. The order in which the
path and "SCANIMAGE"
parameters are specified is how
they will appear in the
R:Twain2PDF list, and then in the
PDF output. If the line contains
the text "SCANIMAGE", the
scanner item will be scanned and
put into image list. Example list
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to load images and to scan items
would be the following:

  c:\Files\File1.JPG

  c:\Files\File2.JPG

  c:\Files\File3.JPG

  SCANIMAGE

  c:\Files\File4.JPG

  c:\Files\File5.JPG

  SCANIMAGE

OPEN_AFTER_SAVE ON
OFF

specifies the if the PDF file is
launched after saving

IMAGE_COMPRESSION_TYPE FLATE
JPEG

specifies the image compression
type

PDF_TITLE value specifies the PDF file title

PDF_SUBJECT value specifies the PDF file subject

PDF_AUTHOR value specifies the PDF file author
name

PDF_KEYWORDS value specifies the PDF file keywords

PDF_CREATOR value specifies the PDF file creator
name

PDF_PAGE_LAYOUT SinglePage
OneColumn
TwoColumnLeft
TwoColumnRight

specifies the PDF file layout type

PDF_PAGE_MODE None
UseOutlines
UseThumbs
FullScreen

specifies the PDF file page mode

PDF_HIDE_TOOLBAR ON
OFF

shows/hides the PDF file toolbar

PDF_HIDE_MENUBAR ON
OFF

shows/hides the PDF file
menubar

PDF_HIDE_WINDOWUI ON
OFF

shows/hides the PDF file UI

PDF_FIT_WINDOW ON
OFF

specifies the PDF file to fit the
window

PDF_CENTER_WINDOW ON
OFF

specifies the PDF file to fit within
the center

PDF_PROTECTION_ENABLED ON
OFF

enables/disables password
protection for PDF file

PDF_OWNER_PASSWORD value specifies the PDF file owner
password 

PDF_USER_PASSWORD value specifies the PDF file user
password

PDF_KEY_LENGTH 40
128

specifies the PDF file encrypted
key length

PDF_PERMISSIONS_PRINT ON
OFF

enables/disables the PDF file
user print permissions

PDF_PERMISSIONS_MODIFY_ANNOTATI
ON

ON
OFF

enables/disables the PDF file
user permissions to change the
annotation

PDF_PERMISSIONS_MODIFY_STRUCTUR
E 

ON
OFF

enables/disables the PDF file
user permissions to modify the
structure

PDF_PERMISSIONS_COPY ON
OFF

enables/disables the PDF file
user permissions to copy
selected text

SHOW_SCANNER_UI ON
OFF

enables/disables the Scanner
User Interface

DPI value specifies the resolution for the
scan output, i.e. 300 (limited to
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scanner options)

SOURCE_NAME value specifies the twain source. The
value should match the value
provided through the
R:Twain2PDF interface when
selecting "File" > "Select Source"
from the menu bar

SCAN_IMAGE_COUNT nnn specifies the number of images
to scan

SCAN_IMAGE_PAUSE_DIALOG ON
OFF

displays a pause dialog between
multiple scans

FILE_NAME_VARIABLE_PREFIX value specifies the variable prefix for
the scanned file name; and can
be used when scanning multi-
page documents

Notes:

· Each option must be separated by the pipe "|" character. 
· No additional PLUGIN command parameter is required for the (ADF) automatic document feeder.

ADF is available if the hardware supports it.
· ADF is automatically used if the feeder bin has contents. Otherwise, the scanner bed is used.

4.3 Examples

4.3.1 Example 1

-- to scan one document to a pdf file without the 
-- R:Twain2PDF and scanner user interface, 
-- with title, subject, author, keywords and creator
-- not launching the final result

PLUGIN RTwain2PDF vResult +

|OUTPUT_FILE RAM_Disclosure.PDF +

|SCAN_IMAGE_COUNT 1 +

|PDF_TITLE RAM Data Systems - Internal +

|PDF_SUBJECT Confidentiality Disclosure +

|PDF_AUTHOR Technical Services Staff  +

|PDF_KEYWORDS disclosure, confidential, internal  +

|PDF_CREATOR RAM Data Systems  +

|SHOW_WINDOW OFF +

|SHOW_SCANNER_UI OFF +

|OPEN_AFTER_SAVE OFF

RETURN

4.3.2 Example 2

-- to scan two images to a pdf file without the R:Twain2PDF 
-- and scanner user interface, with the PDF toolbar, menubar 
-- and user inteface hidden launching the final result in the center

PLUGIN RTwain2PDF vResult +

|OUTPUT_FILE ViewCenter_Clean.PDF +

|SCAN_IMAGE_COUNT 2 +

|SCAN_IMAGE_PAUSE_DIALOG ON +

|SHOW_WINDOW OFF +

|SHOW_SCANNER_UI OFF +

|PDF_HIDE_TOOLBAR OFF  +
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|PDF_HIDE_MENUBAR OFF  +

|PDF_HIDE_WINDOWUI OFF +

|PDF_CENTER_WINDOW ON  +

|OPEN_AFTER_SAVE OFF

RETURN

4.3.3 Example 3

-- to scan one image to a pdf file without the 
-- R:Twain2PDF and scanner user interface, 
-- applying security measures and not
-- launching the final result

PLUGIN RTwain2PDF vResult +

|OUTPUT_FILE FSE_042507_108776.PDF +

|INPUT_FILE STAGE_LIST.TXT +

|SHOW_WINDOW OFF +

|SHOW_SCANNER_UI OFF +

|PDF_PROTECTION_ENABLED ON +

|PDF_OWNER_PASSWORD griffin +

|PDF_USER_PASSWORD atrebek +

|PDF_KEY_LENGTH 128 +

|PDF_PERMISSIONS_PRINT ON  +

|PDF_PERMISSIONS_MODIFY_ANNOTATION OFF  +

|PDF_PERMISSIONS_MODIFY_STRUCTURE OFF + 

|PDF_PERMISSIONS_COPY OFF + 

|OPEN_AFTER_SAVE OFF

RETURN

The contents of the STAGE_LIST.TXT file would be something like the following:

C:\PHOTOS\STAGE19\Audience1.JPG
C:\PHOTOS\STAGE19\Audience2.JPG
C:\PHOTOS\STAGE19\Audience3.JPG
C:\PHOTOS\STAGE19\Audience4.JPG
C:\PHOTOS\STAGE19\Audience5.JPG
C:\PHOTOS\STAGE19\Contestants1.JPG
C:\PHOTOS\STAGE19\Contestants2.JPG
C:\PHOTOS\STAGE19\Contestants3.JPG
C:\PHOTOS\STAGE19\Contestants4.JPG
C:\PHOTOS\STAGE19\Contestants5.JPG
C:\PHOTOS\STAGE19\ATrebek1.JPG
C:\PHOTOS\STAGE19\ATrebek2.JPG
C:\PHOTOS\STAGE19\ATrebek3.JPG
C:\PHOTOS\STAGE19\ATrebek4.JPG
C:\PHOTOS\STAGE19\Jeopardy1.JPG
C:\PHOTOS\STAGE19\Jeopardy2.JPG
C:\PHOTOS\STAGE19\Jeopardy3.JPG

4.3.4 Example 4

-- to perform multiple scans fed from from the automatic document 
-- feeder bin to pdf files without showing the R:Twain2PDF or scanner 
-- user interface

PLUGIN RTwain2PDF vResult +
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  |OUTPUT_FORMAT PDF +

|OUTPUT_FILE Scan_.PDF +

|OUTPUT_FORMAT SINGLE_PDF +

|SCAN_IMAGE_COUNT 1 +

|SHOW_WINDOW OFF +

|SHOW_SCANNER_UI OFF +

|OPEN_AFTER_SAVE OFF

RETURN

No additional PLUGIN command parameter is required for the automatic document feeder. ADF is
available if the hardware supports it.

Based upon the specified file name ,Scan_.PDF, the output files will be named Scan_xxxx.PDF, depending
on the number of pages.
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5 Technical Support

Please read over the help documentation at least once before seeking support. We have worked very
hard to make the help documentation clear and useful, but concise. It is suggested that you reread these
instructions once you have become accustomed to using the software, as new uses will become
apparent.

If you have further questions, and cannot find the answers in the documentation, you can obtain
information from the below sources:

· Email our Technical Support Staff at: support@rbase.com
· Access the R:BASE Technologies Support home page online at https://www.rbase.com/support

You may be required to purchase a technical support plan. Several support plans are available to suit the
needs of all users. Available Technical Support Plans

Please be prepared to provide the following:

· The product registration number, which is located on the invoice/order slip for the purchased product
· The type of operating system and hardware in use
· Details regarding your operating environment; such as available memory, disk space, your version

of R:BASE, local area network, special drivers, related database structures, application files, and
other files that are used or accessed by your application

All provide information will be used to better assist you.

R:BASE Technologies has a number of different services available for R:BASE products. As a registered
user, you will receive information about new features for R:BASE and other R:BASE Technologies
products. Please remember to register your software. https://www.rbase.com/register/

mailto:support@rbase.com
https://www.rbase.com/support
https://www.rbase.com/support/plans.php
https://www.rbase.com/register/
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6 Useful Resources

. R:BASE Home Page: https://www.rbase.com

. Up-to-Date R:BASE Updates: https://www.rbaseupdates.com

. Current Product Details and Documentation: https://www.rbase.com/rbgx5

. Support Home Page: https://www.rbase.com/support

. Product Registration: https://www.rbase.com/register

. Official R:BASE Facebook Page: https://www.facebook.com/rbase

. Sample Applications: https://www.razzak.com/sampleapplications

. Technical Documents (From the Edge): https://www.razzak.com/fte

. Education and Training: https://www.rbase.com/training

. Product News: https://www.rbase.com/news

. Upcoming Events: https://www.rbase.com/events

. R:BASE Online Help Manual: https://www.rbase.com/support/rsyntax

. Form Properties Documentation: https://www.rbase.com/support/FormProperties.pdf

. R:BASE Beginners Tutorial: https://www.rbase.com/support/rtutorial

. R:BASE Solutions (Vertical Market Applications): https://www.rbase.com/products/rbasesolutions

https://www.rbase.com
https://www.rbaseupdates.com
https://www.rbase.com/rbgx5
https://www.rbase.com/support
https://www.rbase.com/register
https://www.facebook.com/rbase
https://www.razzak.com/sampleapplications
https://www.razzak.com/fte
https://www.rbase.com/training
https://www.rbase.com/news
https://www.rbase.com/events
https://www.rbase.com/support/rsyntax
https://www.rbase.com/support/FormProperties.pdf
https://www.rbase.com/support/rtutorial
https://www.rbase.com/products/rbasesolutions
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7 Feedback

Suggestions and Enhancement Requests:

From time to time, everyone comes up with an idea for something they'd like a software product to do
differently. 

If you come across an idea that you think might make a nice enhancement, your input is always
welcome.

Please submit your suggestion and/or enhancement request to the R:BASE Developers' Corner Crew
(R:DCC) and describe what you think might make an ideal enhancement. In R:BASE, the R:DCC Client is
fully integrated to communicate with the R:BASE development team. From the main menu bar, choose
"Help" > "R:DCC Client". If you do not have a login profile, select "New User" to create one.

If you have a sample you wish to provide, have the files prepared within a zip archive prior to initiating
the request. You will be prompted to upload any attachments during the submission process.

Unless additional information is needed, you will not receive a direct response. You can periodically check
the status of your submitted enhancement request. 

If you are experiencing any difficulties with the R:DCC Client, please send an e-mail to rdcc@rbase.com. 

Reporting Bugs:

If you experience something you think might be a bug, please report it to the R:BASE Developers'
Corner Crew. In R:BASE, the R:DCC Client is fully integrated to communicate with the R:BASE
development team. From the main menu bar, choose "Help" > "R:DCC Client". If you do not have a login
profile, select "New User" to create one.

You will need to describe: 

· What you did, what happened, and what you expected to happen
· The product version and build 
· Any error message displayed
· The operating system in use 
· Anything else you think might be relevant 

If you have a sample you wish to provide, have the files prepared within a zip archive prior to initiating
the bug report. You will be prompted to upload any attachments during the submission process.

Unless additional information is needed, you will not receive a direct response. You can periodically check
the status of your submitted bug.

If you are experiencing any difficulties with the R:DCC Client, please send an e-mail to rdcc@rbase.com. 

mailto:rdcc@rbase.com
mailto:rdcc@rbase.com
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